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Please note 
 

• This manual explains how to install the V4 Printer Driver and 
configure the unique function of the V4 Printer Driver. Please 
confirm the operation guide of each printer series about the 
basic print function. 

•  The explanations in this manual assume that you have a 
working knowledge of your Windows computer. 

• For information on your operating system, please refer to 
your operating system manual or the online Help function. 

• The explanations of screens and procedures in this manual 
are primarily for Windows® 10 in Windows environments. 
The screens may vary depending on the version of the 
operating system. 

 

Warning 
 

• All information in this manual is subject to change without 
notice. 

 

 

 

 

 

 

 

 

 

 

 



2 
 

 

 

V4 PRINTER DRIVER 
 

V4 Printer Driver is new architecture form Windows 8.1/Windows Server 2012 R2. 

 

SYSTEM ENVIRONMENT 
V4 PRINTER DRIVER is intended to be used in either one of the following two system environments.  

Server-Client Environment 

The IT admin installs a printer driver to the server, and each client user (or IT admin) installs a printer driver to the 
client PC by Point & Print. At the time of printing, a print job is sent to a printer via the server. 
 

Standalone Environment 
Each user (or IT admin) installs a printer driver to the PC, and in this case, print job goes directly to printer. 
 

OPERATIONAL ENVIRONMENT 

OS compatible* Windows 8.1, Windows 10, Windows Server2012 R2, Windows Server2016 

Emulation PCL6 

Driver UI Language English 

Interface 10BASE-T, 100BASE-T, 1000BASE-T 

Internet protocol IPv4, IPv6 

Display 1024 x 768 dots resolution and 16-bit color or higher is recommended. 

Other hardware requirements An environment that allows any of the above operating systems to fully operate 

 

*1 Itanium is not supported. 
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INSTALLATION 
 
 

STANDARD INSTALLATION

 
Extract the installer that you obtained, and double-
click the [Setup] icon. 
If you have already installed a similar type of driver, an 
install type selection screen will appear. 
 To install the printer driver, click [Add a new Sharp 

printer]. 
 To update a previously installed driver, click [Select Sharp 

Printer to Update]. 

 
Click the [Standard installation] button. 
You can also click the [Specify Condition] button and search 
for the machine by entering the machine's name (host name) 
or IP address, or selecting the search period. 
 

 

 

Check the contents and then click the [Next] button. 

 
 
 This screen is not displayed when only 1 device is found in 

the search results. 
 If the machine is not found, make sure that the machine is 

powered on and that the machine is connected to the 
network, and then click the [Re-search] button. 

 
 
 

 
Follow the on-screen instructions. 
Read the message in the window that appears and click the 
[Next] button. Installation begins. 
 

 
 
 If a warning window regarding security is displayed, do 

not forget to click [Install]. 
 
 
When the installation completed screen appears, click 
the [Finish] button. 
 To set the installed driver as the default printer, select the 

name of the machine from "Set as default printer". If you 
don't want to change the default printer, select [Don't 
change]. 

 To print a test page, click [Print test page]. 
 
This completes the installation. 
After the installation, a message prompting you to restart 
your computer may appear. If this message appears, click the 
[Yes] button to restart your computer. 
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CUSTOM INSTALLATION 

INSTALLATION BY SPECIFYING THE MACHINE ADDRESS 
 

 
Extract the installer that you obtained, and double-
click the [Setup] icon. 
If you have already installed a similar type of driver, an 
install type selection screen will appear. 
 To install the printer driver, click [Add a new Sharp 

printer]. 
 To update a previously installed driver, click [Select Sharp 

Printer to Update]. 

 

Click the [Custom installation] button. 
 
 
When you are asked how the printer is connected, 
select [Specify the MFP IP address] and click the 
[Next] button. 

 
 
 
Enter the name (host name) or IP address of the 
machine and click the [Next] button. 

 
 Configure port settings if needed. (Normally no changes 

are needed.) 
 
 
 
 
 
 
 
 
 
 
 
 

When the printer driver selection window appears, 
select the printer driver to be installed and click the 
[Next] button. 
Click the checkbox of the printer driver to be installed so 
that a checkmark ( ) appears. 

 
 You can click [Printer name] to change the printer name. 
 By selecting the model name from the list and clicking 

[Add a printer], you can copy the driver settings and install 
multiple drivers for the same model, each with a different 
name. 
 To share the printer, select the [Share this printer] 

checkbox . 
 
 
Follow the instructions on the screen and proceed 
with installation. 
 Check the content of the displayed screen. Click the [Next] 

button to proceed with installation. 
 
If a warning window regarding security is displayed, do not 
forget to click [Install]. 

 
 
Click the [Finish] button. 
 To set the installed driver as the default printer, select 

the name of the machine from "Set as default printer".  
If you don't want to change the default printer, select 
[Don't change]. 
 To print a test page, click [Print test page]. 
 

This completes the installation. 
After the installation, a message prompting you to restart your 
computer may appear. If this message appears, click the [Yes] 
button to restart your computer. 
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INSTALLATION BY SEARCHING FOR THE MACHINE 
 

Extract the installer that you obtained, and double-
click the [Setup] icon. 
If you have already installed a similar type of driver, an 
install type selection screen will appear. 
 To install the printer driver, click [Add a new Sharp 

printer]. 
 To update a previously installed driver, click [Select Sharp 

Printer to Update]. 

 

 
Click the [Custom installation] button. 
 
 
When you are asked how the printer is connected, 
select [Search for MFP] and click the [Next] button. 

 
 
 
Select the search method. 
Select the name of this machine (host name) or IP address, 
then click the [Next] button. 

 
 Configure port settings if needed. (Normally no changes 

are needed.) 
 
 
 
 
 
 

 
 
When the model selection window appears, select 
the model name of your machine and click the 
[Next] button. 
You can also click the [Specify Condition] button and search 
for the machine by entering the machine's name (host 
name) or IP address, or selecting the search period. 

 
 
 
Follow the instructions on the screen and proceed 
with installation. 
For detailed procedures, refer to Step 4 onwards of 
"INSTALLATION BY SPECIFYING THE MACHINE ADDRESS 
(Page.4)". 
 

This completes the installation. 
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INSTALL THE DRIVER USING AN EXISTING PORT 
 

 
Extract the installer that you obtained, and double-
click the [Setup] icon. 
If you have already installed a similar type of driver, an 
install type selection screen will appear. 
 To install the printer driver, click [Add a new Sharp 

printer]. 
 To update a previously installed driver, click [Select Sharp 

Printer to Update]. 

 
Click the [Custom installation] button. 
 
 
Select [Use an existing port] and click the [Next] 
button. 

 
 
 
Select the port. 
 You can click a [Port] that you want to change in the list 

and select the desired port. 
 To create a new port, click [Add Port]. For detailed 

procedures, refer to Step 4 onwards of "CHANGING THE 
PORT (Page. 9)". 

 
 
 
Follow the instructions on the screen and proceed 
with installation. 
For detailed procedures, refer to Step 5 onwards of 
"INSTALLATION BY SPECIFYING THE MACHINE ADDRESS 
(Page.4)". 
 

This completes the installation. 
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INSTALLING THE DRIVER ONLY 
 

 
Extract the installer that you obtained, and double-
click the [Setup] icon. 
If you have already installed a similar type of driver, an 
install type selection screen will appear. 
 To install the printer driver, click [Add a new Sharp 

printer]. 
 To update a previously installed driver, click [Select Sharp 

Printer to Update]. 

 
Click the [Custom installation] button. 
 
 
Select [Register the driver to OS (Operating System)] 
and click the [Next] button. 

 
 
 
Confirm the content of the screen, and click the 
[Next] button. 
Installation begins. When the complete screen is displayed, 
click [Finish]. 
 
If a warning window regarding security is displayed, do not 
forget to click [Install]. 
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ENABLE OPTIONS AND PERIPHERALS 
 

 
Click the [Start] button, click [Control Panel], and 
then click [Devices and Printers] (or [View devices 
and printers]). 
 
Open the printer properties window. 
(1) Right-click the printer driver icon of the machine. 
(2) Select [Printer properties]. 

 
Click the [Device Settings] tab. 
 

 

Set [Install Options]. 

 

 
Click the [OK] button in the printer properties window. 
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CHANGING THE PORT 
 

 
Click the [Start] button, click [Control Panel], and 
then click [Devices and Printers] (or [View devices 
and printers]). 
 
Open the printer properties window. 
(1) Right-click the printer driver icon of the machine. 
(2) Select [Printer properties]. 

 
Adding or changing a port. 
(1) Click the [Ports] tab. 
(2) Click the [Add Port] button. 

 
To change to an existing port, select the port from the list and 
click the [Apply] button. 

 

Select the port type and click the [New Port] button. 
 Standard TCP/IP Port 

This is the standard printer port provided by the 
operating system. 
(1) Click the [Next] button. 
(2) Enter the machine's IP address in [Printer Name or IP 

Address] and click the [Next] button. 
(3) Click the [Finish] button. 
 

 
Click the [Close] button in the screen of step 4. 

 
 
Click the [Apply] button in the screen of step 3. 

 
When using a port created using "Standard TCP/IP Port", in 
the screen that appears after you click the [Configure Port] 
button in the screen of step 3, make sure the [SNMP Status 
Enabled] checkbox is not selected ( ). If the [SNMP Status 
Enabled] checkbox is selected ( ), it may not be possible to 
print correctly. 
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REMOVING THE DRIVER 
To remove the software installed using the installer, follow the steps below. 

 
 

 
Click the [start] button and then click [Control 
Panel]. 
 
Click [Programs and Features] (or [Uninstall a 
program]). 
 
Select [SHARP Driver Uninstall Tool] and click 
[Uninstall]. 
 
Select the printer driver that you want to delete from 
the list, and click the [Remove] button. 
 
Click the [Close] button. 

 
 
 
Select the other software that you want to delete from 
the list, and delete. 

 

Restart your computer. 
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PRINTER FUNCTION 
 

PRINTING IN A WINDOWS ENVIRONMENT 

BASIC PRINTING PROCEDURE 
The following example explains how to print a document from "WordPad", which is a standard accessory application in 
Windows. 
 
 The menu used to execute printing may vary depending on the application. 
 The button that is used to open the printer driver properties window (usually [Property] or [Preferences]) may vary 

depending on the application. 
 
 

 
Select [Print] from the [File] menu of WordPad. 

 

 
Select the printer driver for the machine and click the 
[Preferences] button. 
The button that is used to open the printer driver properties 
window (usually [Property] or [Preferences]) may vary 
depending on the application. 

 
 

 

Select print settings. 

(1)  Click the [Main] tab. 

(2)  Select the original size. 
 To select settings on other tabs, click the desired tab and 

then select the settings. 
 PRINTER DRIVER SETTINGS SCREEN (page 12) 

 If an original size larger than the largest paper size that the 
machine supports is set, select the paper size for printing in 
“Output Size”. 

 If an "Output Size" different from the "Original Size" is 
selected, the print image will be adjusted to match the 
selected paper size.  

 

(3)  Click the [OK] button. 

 
 

Click the [Print] button. 

Printing begins. 
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PRINTER DRIVER SETTINGS SCREEN 
The printer driver settings screen consists of 8 tabs. Click a tab to select the settings on that tab. 
 

 

(1) Tabs: Click   to change the tabs shown. 
 [Main]:  Frequently used functions are grouped on this tab. The settings are also on other tabs, and each setting on  

   this tab is linked to the corresponding setting on the other tab. 
 [Paper Source]:   Set the size and type of paper used for printing, and the paper tray. 
 [Finishing]:   Select a finishing function such as stapling and punch. 
 [Layout]:   Select functions related to the layout such as two-sided printing and booklet. 
 [Job Handling]:   Set Document Filing and user authentication. 
 [Stamp]:   Set the watermark. 
 [Image Quality]:  Set color mode. 
 [Detailed Settings]: Set other detailed print settings. 

(2) Favorites 
Settings configured on each tab at the time of printing can be saved as Favorite. 
FREQUENTLY USED FUNCTIONS (page 15) 

(3) [Defaults] 
Return the settings on the currently selected tab to their default state. 

(4) Setup Items 
Displays the settings on each tab. 

(5) Print image 
This lets you visually check how the current settings affect the print image. Finishing settings are indicated by icons. 

(6) [About] button 
Displays the version of the printer driver. 

 

  

(1) 

(2) 

(4) 

(3) 

(5) 

(6) 
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SELECTING THE PAPER 
Before printing, check the paper sizes, paper types, and paper remaining in the machine's trays.  
The "Output Size" setting and the "Paper Tray" setting are related as follows: 
 
 When "Paper Tray" is set to [Automatically Select] 

The tray that contains paper of the size set in "Form To Tray Assignment" of “Device Settings” tab is automatically selected. 
 When "Paper Tray" is set to [Printer Auto Select] 

The tray that contains paper of the size and type selected in "Output Size" and "Paper Type" is automatically selected by the printer. 
 When "Paper Tray" is set to any setting other than [Auto Select] 

The specified tray is used for printing regardless of the "Output Size" setting. 
When you have set "Paper Type" to [Bypass Tray], be sure to select "Paper Type". Check the paper type that is set for the bypass tray of 
the machine, check that paper of that type is actually loaded into the bypass tray, and then select the appropriate paper type. 
 When "Paper Type" is set to [Auto Select] 

A tray with plain paper or recycled paper of the size specified in "Output Size" is automatically selected. (The factory default setting is 
plain paper only.) 
 When "Paper Type" is set to anything other than [Auto Select] 

A tray with the specified type of paper and the size specified in "Output Size" is used for printing. 
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PRINTING WHEN THE USER AUTHENTICATION FUNCTION IS ENABLED 
The user information (such as login name and password) that must be entered varies depending on the authentication method 
being used, so check with the administrator of the machine before printing. 
 
 
To prohibit printing by users whose user information is not stored in the machine: 
In "Settings (administrator)", select [User Control] > [Default Settings] > [Disable Printing by Invalid User]. 
 
 

 
In the printer driver properties window of the 
application, select the printer driver of the machine 
and click the [Preferences] button. 
The button that is used to open the printer driver properties 
window (usually [Property] or [Preferences]) may vary 
depending on the application. 

 

Enter your user information. 

(1) Click the [Job Handling] tab. 

(2) Enter your user information. 
 When authentication is performed by login name, 

select [Login Name] and enter your login name. 
 When authentication is performed by login 

name/password, click [Login Name/Password] and 
enter your login name and password. Enter the 
password using 1 to 32 characters. 
 When authentication is performed by user number, 

select [User Number] and enter your 5 to 8 digit user 
number. 

(3)  Enter the user name and job name as necessary. 
 Click the [User Name] checkbox, and enter your user 

name using up to 32 characters. The entered user 
name will appear on the touch panel of the machine. 
If you do not enter a user name, your PC login name 
will appear. 
 Click the [Job Name] checkbox, and enter a job name 

using up to 80 characters. The entered job name will 
appear as a file name on the touch panel of the 
machine. If you do not enter a job name, the file 
name set in the application will appear. 

 
(4)  Click the [OK] button to execute printing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



15 

 

FREQUENTLY USED FUNCTIONS 

This section explains frequently used functions. 
The explanations assume that the paper size and other basic settings have already been selected. For the basic  
procedure for printing and the steps for opening the printer driver properties window, see the BASIC PRINTING PROCEDURE 
section: 
 
SAVING SETTINGS AT THE TIME OF PRINTING 
Settings configured on each of the tabs at the time of printing can be saved as Favorite. Saving frequently used settings under 
an assigned name makes it easy to select those settings the next time you need to use them. 
Settings can be saved from any tab of the printer driver properties window. Settings configured on each tab are listed at the 
time of saving, allowing you to check the settings as you save them. 
 

 

 (1) Select the machine's printer driver from the print window of the application, and click the [Preferences] button. 
The button that is used to open the printer driver properties window (usually [Property] or [Preferences]) may vary depending on the 
application. 

(2) Register Print Settings. 
(1) Configure the print settings on each tab. 
(2) Click the [Save] button. 

 

 

(3) Check and save the settings. 
Check and save the settings. 
(1) Check the displayed settings. 
(2) Enter a name for the settings using up to20 characters. 
(3) Click the [OK] button
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USING SAVED SETTINGS 
You can specify the saved favorites through just one click to apply frequently used settings to your printing. 
 

 

(1) Select the machine's printer driver from the print window of the application, and click the [Preferences] button. 
The button that is used to open the printer driver properties window (usually [Property] or [Preferences]) may vary depending on the 
application. 

(2) Select favorite settings. 
(1) Select the favorite settings you want to use. 
(2) Click the [OK] button. 

 

 

(3) Start printing. 
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CHANGING THE PRINTER DRIVER DEFAULT SETTINGS 
You can change the default settings of the printer driver. 
Changes you have made in the printer driver properties window when you execute printing from the application are returned 
to the default settings specified here when you exit the application. 
 

 

(1) Right-click the [Start] button and select [Control Panel]. 
The button that is used to open the printer driver properties window (usually [Property] or [Preferences]) may vary depending on the 
application. 
 

(2) Click [View devices and printers] in [Hardware and Sound]. 

(3) Right-click the printer driver icon of the machine and select [Printer Properties]. 

 
 

(4) Click the [Preferences] button on the [General] tab. 

 
 

(5) Configure the settings and click the [OK] button. 
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SELECTING THE COLOR MODE 

This section explains how to select the color mode in the printer driver properties window. The following three selections are 
available for the color mode: 
Automatic:  The machine automatically determines whether each page is color or black and white and prints the page accordingly. 

Pages with colors other than black and white are printed using Y (Yellow), M (Magenta), C (Cyan) and Bk (Black) toner. 
Pages that are only black and white are printed using Bk (Black) toner only. This is convenient when printing a document 
that has both color and black and white pages, however, the printing speed is slower. 

Color:  All pages are printed in color. Both color data and black and white data are printed using Y (Yellow), M (Magenta), C (Cyan) 
and Bk (Black) toner. 

Black and White:  All pages are printed in black and white. Color data such as images or materials for a presentation are printed using black 
toner only. This mode helps conserve color toner when you do not need to print in color, such as when proofreading or 
checking the layout of a document. 

 
When "Color Mode" is set to [Automatic] 
Even if the print result is black and white, the following types of print jobs will be counted as 4-color (Y (Yellow), M (Magenta),  
C (Cyan), and Bk (Black)) print jobs. To be always counted as a black and white job, select [Black and White]. 
 When the data is created as color data. 
 When the application treats the data as color data even though the data is black and white. 
 When an image is hidden under a black and white image. 

 

 

COLOR MODE SETTINGS 

 

 

(1)Click the [Main] tab. 

(2)Select the "Color Mode" that you wish to use. 

 

This setting also can be set on [Image Quality] tab.
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TWO-SIDED PRINTING 
The machine can print on both sides of the paper. This function is useful for many purposes, and is particularly convenient 
when you want to create a simple pamphlet. 2-sided printing also helps conserve paper. 
 

Paper orientation Print results 

Portrait 

Long Edge Short Edge 

 

 

 

 

 

Landscape 

Short Edge Long Edge 

  

 

 

 

 The Pages are printed so that they 
can be bound at the left or right side. 

The Pages are printed so that they 
can be bound at the top. 

 

 

 

 

(1) Click the [Main] tab.  

(2) Select the paper orientation. 

(3) Select [Long Edge] or [Short Edge].
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FITTING THE PRINT IMAGE TO THE PAPER 
This function automatically enlarges or reduces the print image to match the size of the paper loaded in the machine.  
This function is convenient when enlarging a letter or A4 size document to ledger or A3 size to make it easier to view, or when 
printing a document on paper that is different in size from the original document. 

 

 

 

The following example explains how to print a letter (or A4) size document on ledger (or A3) size paper. 

 

 

 

(1) Click the [Main] tab. 

(2) Select the original size from [Original Size] (for example: Letter). 

(3) Select the actual paper size to be used for printing from [Output Size] (for example: Ledger). 

If the output size is larger than the original size, the printed image will be automatically enlarged. 
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PRINTING MULTIPLE PAGES ON ONE PAGE 
This function reduces the print image and prints multiple pages on a single sheet of paper. You can print only the first page in 
the original size and print multiple reduced pages on the subsequent sheets. 
For example, when [2-Up] (2 pages per sheet) or [4-Up] (4 pages per sheet) is selected, the following print results will be 
obtained, depending on the selected page order. 
This is convenient when you want to print multiple images such as photos on a single sheet of paper, and when you want to 
conserve paper. When used in combination with 2-sided printing, this function saves more paper. 
 

N-Up 
(Pages per sheet) 

Print results 

Left To Right Right To Left 
Top To Bottom 

(When the print orientation is 
landscape) 

2-Up 
(2 pages per sheet) 

   
 

N-Up 
(Pages per sheet) Right, and Down Down, and Right Left, and Down Down, and Left 

4-Up 
(4 pages per sheet) 

    
 
 [N-Up] that can be set on the [Layout] tab can also be set on the [Main] tab. ("Order" can only be set in the [Layout] tab.) 
 Note the following when printing multiple pages on one sheet: 
 The page orders for 6-Up, 8-Up, 9-Up, and 16-Up are the same as for 4-Up. 
 In a Windows environment, the page order can be viewed in the print image in the printer driver properties window. 

 

 

 

(1) Click the [Layout] tab. 

(2) Select the number of pages per sheet. 

(3) Select the order of the pages. 

(4) If you wish to print borderlines, click the [Border] checkbox so that the checkmark  appears. 
 To print the first page normally (as a cover), select the [N-Up with cover] checkbox ( ). 
 When [100% N-Up] is selected ( ) for jobs such as N-Up copying of two A4 size pages onto one A3 sheet, the pages will be printed at 

the full size of the original. If you select [Border] at this time, only the border will be printed. 
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STAPLING OUTPUT / PUNCHING HOLES IN OUTPUT 
Staple function 
The staple function staples the output. To create materials with more sophisticated appearance, the staple function can be 
used in combination with 2-sided printing. 
This function saves considerable time when preparing handouts for a meeting or other stapled materials. 
The stapling positions and the number of staples can be selected to obtain the following stapling results. 
 

Staple Left Right Top 

1 Staple* 

   

2 Staple 

   
* The staple orientation varies depending on the size and orientation of the paper. 

 

Punch function 

The punch function punches holes in the output. The punch hole positions are set by selecting the binding edge. 
Left Right Top 

   

 
 A finisher or saddle stitch finisher is required to use the staple function. 
 To use the punch function, installing a punch module in the finisher or saddle stitch finisher. 
 For the maximum number of sheets that can be stapled, see "SPECIFICATIONS" in the Start Guide. 
 For information on the saddle stitch function, see "CREATE A PAMPHLET (BOOKLET/ SADDLE STITCH) (page 24)". 

 
 The staple and offset (shifting the position of the paper that is output for each job) functions cannot be used 

simultaneously. 
 When the finisher is disabled in the machine's settings, the staple function and punch function cannot be used. 
 When the staple function or the punch function is disabled in the machine's settings, stapling or punching is not possible. 
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(1) Click the [Finishing] tab. 

(2) Select the staple function or the punch function. 
 For the staple function, select the number of staples in the "Staple" menu and the staple position in the “Position” menu. 
 For the punch function, select the type of punch in the "Punch" menu and the punch position in the "Position" menu. 

 

In addition to the [Finishing] tab, [Staple] can also be set on the [Main] tab. 
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CONVENIENT PRINTING FUNCTIONS 

This section explains convenient functions for specific printing objectives. 
The explanations assume that the paper size and other basic settings have already been selected. For the basic procedure for 
printing and the steps for opening the printer driver properties window, see Basic Printing Procedure section: 

 

CREATE A PAMPHLET (BOOKLET/ SADDLE STITCH) 
The pamphlet function prints on the front and back of each sheet 
of paper so that the sheets can be folded and bound to create a 
pamphlet. 
If a saddle stitch finisher is installed and if "Booklet" and "Staple" 
are selected, this function automatically folds and outputs the 
copies. This is convenient when you wish to compile printed 
output into a pamphlet. 

 

 

 

(1) Click the [Layout] tab. 

(2) Select [Standard] in "Booklet". 
 The printed image will be enlarged or reduced to fit the paper selected in "Output Size". 

(3) Select the specified output size and the binding edge. 
 Select the output paper size. 

 
In [Paper Tray] settings of [Paper Source] tab, select [Printer Auto Select] for correct printing. 

 

If a saddle stitch finisher is installed 

 

(4) Click the [Finishing] tab. 

(5) Select [Saddle Stitch] from "Staple".  
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PRINTING WITH MARGIN SHIFT SETTING (MARGIN) 
This function shifts the print image to increase the margin at the 
left, the right, or the top of the paper. 
If a finisher or saddle stitch finisher is installed, the staple and 
punch functions of the machine can also be used together. 
This is convenient when you wish to staple or punch the output 
but the binding area overlaps the text. By shifting the image, the 
part of the image that is outside the print area will not be printed. 

 

 

 

 

(1) Click the [Layout] tab. 

(2) Click the [Print Position] button. 

(3) Select [Margin Shift]. 

(4) Select the shift width. 

Select from the "Margin Shift" menu. If you wish to configure another numeric setting, select the setting and click   buttons or 
directly enter the number. 
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ADJUST PRINT POSITION ON ODD AND EVEN PAGES SEPARATELY (PRINT POSITION) 
This function sets different print positions (margins) separately for odd and even pages and prints the pages. 

 

 

 

(1) Click the [Layout] tab. 

(2) Click the [Print Position] button. 

(3) Select [Custom]. 

(4) Set the amount of shifting of the print position for odd-numbered pages and even-numbered pages. 

(5) Click the [OK] button. 
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ROTATING THE PRINT IMAGE 180 DEGREES (ROTATE 180 DEGREES) 
  
This feature rotates the image 180 degrees so that it can be 
printed correctly on paper that can be loaded in only one 
orientation (such as paper with punch holes). 
 

 

 

 

 

(1) Click the [Main] tab. 

(2) Select [Portrait (Rotated)] or [Landscape (Rotated)] in "Orientation". 
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ENLARGING/REDUCING THE PRINT IMAGE (ZOOM SETTING/ENLARGE OR REDUCE) 
 
This function enlarges or reduces the image to a selected 
percentage. This allows you to enlarge a small image or add 
margins to the paper by slightly reducing an image. 
 

 

 

 

 

 

(1) Click the [Main] tab. 

(2) Click the [Zoom] checkbox so that  appears, and click the [Settings] button. 

(3) Enter the percentage. 

By clicking the   button, you can specify the value in increments of 1%. In addition, select [Upper Left] or [Center] for the base point 
on the paper. 

(4) Click the [OK] button. 
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ADDING A WATERMARK TO PRINTED PAGES (WATERMARK) 
This function adds faint shadow-like text as a watermark in the 
background of the printed image. The size and angle of the 
watermark text can be adjusted. 
The watermark text can be selected from the previously 
registered text in the list. When necessary, you can enter text to 
create an original watermark. 
 

 

 

 

(1) Click the [Stamp] tab. 

(2) Select [Watermark] from "Stamp" and click the [Settings] button. 

(3) Select the watermark to be used and click the [OK] button. 

 

If you want to create a new watermark, enter the text of the watermark in the text box and click the [Add] button. 
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MAXIMIZING THE PRINT AREA ON THE PAPER (PRINT AREA) 
By maximizing the print area, you can print on the full paper size. 
 

Even when the print area is maximized, edges may be cut off. 

 

 

 
 

(1) Click the [Detailed Settings] tab. 

(2) Click the [Other Settings] button. 

(3) Select [Maximum] from the "Printable Area". 

(4) Click the [OK] button. 
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SAVING AND USING PRINT FILES (Document Filing) 
This function stores a print job as a file on the machine's hard drive, allowing 
the job to be printed from the touch panel when needed. The location for 
storing a file can be selected to prevent the file from being mixed together 
with files of other users. 
 

Hold Only 
This setting is used to hold a print job on the target printer's hard drive 
without printing it. 
Hold After Print 

This setting is used to hold a print job on the target printer's hard drive 
after it is printed. 

Sample Print 
When a print job is sent to the target printer, only the first set of copies is printed. After checking the contents of the first set 
of copies, you can print the remaining sets from the operation panel of the target machine. This prevents the occurrence of 
excessive misprints. 

 
 When printing from a PC, you can set a password (5 to 8 digits) to maintain the confidentiality of information in a stored file. When a 

password is set, the password must be entered to print data. 
 [Document Filing] that can be set on the [Job Handling] tab can also be set on the [Main] tab. 

 

 

 
(1) Click the [Job Handling] tab. 

(2) Select the function from the "Document Filing". 

(3) Select the folder for storing the file in “Stored to”. 

To enter a password (5 to 8 digit number), click the [PIN Code] checkbox so that the checkmark  appears. 

 
 When [Quick File] is selected, "Document Filing" will be set to [Hold After Print]. 
 When [Quick File] is selected, the password entered in "Document Filing" is cleared. 

 
If you have configured to always use the force document filing function in "Printing Policy" on the [Device Settings] tab, you cannot clear 
the [Document Filing] checkbox. 

 

  



 
 

  

 

 AUTOMATICALLY PRINT ALL STORED DATA 
When user authentication is enabled on the machine, all document filing (stored) print jobs of the user who logs in are 
automatically printed. After all jobs are printed, the stored jobs are deleted. 
 

To use the Print All function, the following steps are necessary: 

 In "Settings (administrator)", select [User Control] > [Default Settings] and enable [Automatically print stored jobs after login]. 
 When executing document filing print, in addition to the user authentication information, enter the user name stored in the machine 

in "User Name" of "Default Job ID" in the printer driver. 

 
Files with a password and files that are protected by the document filing function of the machine will not be printed. Files in a folder 
(excluding My Folder) that has a password will also not be printed. 
 
 
 

(1) Select [Job Handling]. 
At the time of document filing print, in addition to the user authentication information, enter the user name stored in 
the machine in "User Name" in the printer driver. 

(2) A confirmation prompt will appear. Tap the [OK] key. 
The print files stored in the quick file folder, main folder, and custom folder will be printed automatically and then 
deleted.
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TRADEMARK ACKNOWLEDGMENT 
 

 

The following trademarks and registered trademarks are used in conjunction with this software. 

 

•  Windows® 8.1, Windows® 10, Windows Server® 2012 R2 and Windows Server® 2016 are registered trademarks or 

trademarks of Microsoft Corporation in the U.S.A. and other countries. 

• PCL is a registered trademark of the Hewlett-Packard Company. 
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